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Manage Circuits
This chapter explains how to manage Cisco ONS 15310-MA SDH electrical, optical, and Ethernet
circuits. To create circuits, see Chapter 5, “Create Circuits and VC Low-order Path Tunnels.”

Before You Begin
To clear any alarm or trouble conditions, refer to the Cisco ONS 15310-MA SDH Troubleshooting Guide.
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).
1.

NTP-H69 Locate and View Circuits, page 6-2—Complete as needed.

2.

NTP-H70 View Cross-Connect Resource Usage, page 6-2—Complete as needed.

3.

NTP-H71 Modify and Delete Circuits, page 6-3—Complete as needed to edit a circuit name; change
the active and standby colors of spans; change signal fail thresholds, signal degrade thresholds,
reversion time, and payload defect indication path settings for path protection circuits; or add or
delete a virtual concatenated (VCAT) member.

4.

NTP-H72 Modify and Delete Overhead Circuits and Server Trails, page 6-4—Complete as needed
to change a tunnel type, repair an IP circuit, or delete overhead circuits and server trails.

5.

NTP-H73 Create a Monitor Circuit, page 6-4—Complete as needed to monitor traffic on primary
bidirectional circuits.

6.

NTP-H144 Create a J0 Section Trace, page 6-5—Complete as needed to monitor interruptions or
changes to circuit traffic.

7.

NTP-H74 Create a J1 Path Trace, page 6-7—Complete as needed to monitor interruptions or
changes to circuit traffic.

8.

NTP-H75 Create a J2 Path Trace, page 6-7—Complete as needed to monitor interruptions or
changes to circuit traffic on the CE-100T-8 card.

9.

NTP-H129 Bridge and Roll Traffic, page 6-10—Complete as needed to reroute live traffic without
interrupting service.

10. NTP-H76 Reconfigure Circuits, page 6-11—Complete as needed to reconfigure (rebuild) circuits.
11. NTP-H77 Merge Circuits, page 6-11—Complete as needed to merge two circuits into a master

circuit.
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NTP-H69 Locate and View Circuits
Purpose

This procedure allows you to locate and view ONS 15310-MA SDH
circuits. You can also export circuit data from the Circuits and Edit Circuits
windows.

Tools/Equipment

None

Prerequisite Procedures Circuit creation procedures in Chapter 5, “Create Circuits and VC
Low-order Path Tunnels.”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43 on a node in the network where you want
to view the circuits. If you are already logged in, continue with Step 2.

Step 2

As needed, complete the “DLP-H107 View Circuit Information” task on page 17-9.

Step 3

As needed, complete the “DLP-H78 Search for Circuits” task on page 16-95.

Step 4

As needed, complete the “DLP-H109 Filter the Display of Circuits” task on page 17-12.

Step 5

As needed, complete the “DLP-H110 View Circuits on a Span” task on page 17-14.

Step 6

As needed, complete the “DLP-H223 Export CTC Data” task on page 18-20.
Stop. You have completed this procedure.

NTP-H70 View Cross-Connect Resource Usage
Purpose

This procedure displays the percentage of cross-connect resources used by
circuits that traverse or terminate at an ONS 15310-MA SDH.

Tools/Equipment

None

Prerequisite Procedures None
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43 at the node where you want to view the
cross-connect card resource usage. If you are already logged in, continue with Step 2.

Step 2

Click the Maintenance > Cross-Connect > Resource Usage tabs.

Step 3

In the Summary section of the Resources Usage tab, view the following information:
•

VC4 Matrix—Provides the percent of the cross-connect synchronous transport signal ( VC
high-order path) resources that are used. For the 15310E-CTX-K9, 128 VC4 ports are available.

•

TUG3 Matrix—Provides the percent of the cross-connect synchronous transport signal ( VC
Low-order path) resources that are used. For the 15310E-CTX-K9, 96 VC3 ports are available.
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•
Step 4

VC12 Matrix—Provides the percent of the cross-connect synchronous transport signal ( VC
low-order path) resources that are used. For the 15310E-CTX-K9, 128 VC4 ports are available.

In the VC low-order path Matrix Port Detail section, you can view details of the VC low-order path
Matrix Port usage:
•

Drop—Identifies the source slot, port, and VC high-order path.

•

Tunnel Name—Displays the VC low-order path tunnel name if the VC low-order path port is on a
VC low-order path tunnel origination or termination port.

•

% Used—Shows the percent of the matrix port that is used. Each matrix port can carry 21 VC12s

•

Usage—Shows the port usage. For example, if one VC high-order path carries 21 VC12 circuits, the
matrix port will show 21 of 21 are used.

Stop. You have completed this procedure.

NTP-H71 Modify and Delete Circuits
Purpose

This procedure modifies and deletes ONS 15310-MA SDH circuits.

Tools/Equipment

None

Prerequisite Procedures Circuits must exist on the network. See Chapter 5, “Create Circuits and VC
Low-order Path Tunnels.” for circuit creation procedures.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43 at a node on the network containing the
circuit you want to modify. If you are already logged in, continue with Step 2.

Step 2

As needed, complete the “DLP-H111 Change a Circuit Service State” task on page 17-15.

Step 3

As needed, complete the “DLP-H112 Edit a Circuit Name” task on page 17-16.

Step 4

As needed, complete the “DLP-H113 Change Active and Standby Span Color” task on page 17-17.

Step 5

As needed, complete the “DLP-H115 Delete Circuits” task on page 17-19.

Step 6

As needed, complete the “DLP-H241 Edit Path Protection Dual-Ring Interconnect Circuit Hold-Off
Timer” task on page 18-47.

Step 7

As needed, complete the “DLP-H115 Delete Circuits” task on page 17-19.

Step 8

As needed, complete the “DLP-H180 Change a VCAT Member Service State” task on page 17-70.

Step 9

As needed, complete the “DLP-H116 Add a Member to a VCAT Circuit” task on page 17-20.

Step 10

As needed, complete the “DLP-H117 Delete a Member from a VCAT Circuit” task on page 17-24.
Stop. You have completed this procedure.
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NTP-H72 Modify and Delete Overhead Circuits and Server Trails
Purpose

This procedure changes the tunnel type, repairs IP circuits, and deletes
overhead circuits and server trails.

Tools/Equipment

None

Prerequisite Procedures Circuits must exist on the network. See Chapter 5, “Create Circuits and VC
Low-order Path Tunnels.”

Caution

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Deleting circuits can be service affecting and should be performed during a maintenance window.

Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43 at a node on the network containing the
circuit you want to modify. If you are already logged in, continue with Step 2.

Step 2

As needed, complete the “DLP-H118 Change Tunnel Type” task on page 17-25.

Step 3

As needed, complete the “DLP-H119 Repair an IP Tunnel” task on page 17-25.

Step 4

As needed, complete the “DLP-H120 Delete Overhead Circuits” task on page 17-26.

Step 5

As needed, complete the “DLP-H232 Delete a Server Trail” task on page 18-31.
Stop. You have completed this procedure.

NTP-H73 Create a Monitor Circuit
Purpose

This procedure creates a monitor circuit that monitors traffic on primary,
bidirectional circuits.

Tools/Equipment

None

Prerequisite Procedures Bidirectional (two-way) circuits must exist on the network. See Chapter 5,
“Create Circuits and VC Low-order Path Tunnels.” for circuit creation
procedures.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

Monitor circuits cannot be used with EtherSwitch circuits.

Note

For unidirectional circuits, create a drop to the port where the test equipment is attached.
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Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43 on an ONS 15310-MA SDH node on the
network where you want to create the monitor circuit. If you are already logged in, continue with Step 2.

Step 2

From the View menu, choose Go to Network View.

Step 3

Click the Circuits tab.

Step 4

Choose the bidirectional (two-way) circuit that you want to monitor and click Edit.

Step 5

Verify that the circuit name is no longer than 44 characters. Monitor circuits append a “_MON” to the
circuit name. If the name is longer than 44 characters, edit the name in the Name field, then click Apply.

Note

Step 6

If the circuit name is longer than 44 characters, it appends “_MON” after truncating the circuit
name to 40 characters.

In the Edit Circuit window, click the Monitors tab.
The Monitors tab provides ports that you can use to monitor the circuit. The Monitor tab is only available
when the circuit has a DISCOVERED status.

Step 7

In the Monitors tab, choose the monitor source port. The monitor circuit displays traffic coming into the
node at the port you choose.

Step 8

Click Create Monitor Circuit.

Step 9

In the Circuit Destination section of the Circuit Creation wizard, choose the destination node, slot, port,
VC high-order path, VC low-order path, or E1 for the monitored circuit.

Step 10

Click Next.

Step 11

In the Circuit Routing Preferences area, review the monitor circuit information.

Step 12

Click Finish.

Step 13

In the Edit Circuit window, click Close. The new monitor circuit appears on the Circuits tab.
Stop. You have completed this procedure.

NTP-H144 Create a J0 Section Trace
Purpose

This procedure creates a repeated, fixed-length string of characters used to
monitor interruptions or changes to traffic between nodes.

Tools/Equipment

An ONS 15310-MA SDH 15310E-CTX-K9, E1_63_E3_DS3_3, or
E1_21_E3_DS3_3 card must be installed. J0 section trace applies to
optical ports.

Prerequisite Procedures None
Required/As Needed

As needed (optional if path trace is set)

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher
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Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43 at a node on the network where you will
create the section trace. If you are already logged in, continue with Step 2.

Step 2

In node view, double-click the 15310E-CTX-K9, E1_63_E3_DS3_3, or E1_21_E3_DS3_3 card.

Step 3

Click the Provisioning > E3 or Optical > Section Trace tabs.

Step 4

From the Port drop-down list, choose the port for the section trace.

Step 5

From the Trace Mode drop-down list, enable the section trace expected string by choosing Auto or
Manual:
•

Auto—The first string received from the source port is automatically provisioned as the current
expected string. An alarm is raised when a string that differs from the baseline is received.

•

Manual—The string entered in the Current Expected String field is the baseline. An alarm is raised
when a string that differs from the Current Expected String is received.

Step 6

In the Section Trace String Size area, click 1 byte, 16 byte, or 64 byte. In the New Transmit String field,
enter the string that you want to transmit. Enter a string that makes the destination port easy to identify,
such as the node IP address, node name, or another string. If the New Transmit String field is left blank,
the J0 transmits a string of null characters.

Step 7

If you set the Section Trace Mode field to Manual, enter the string that the destination port should receive
from the source port in the New Expected String field. If you set Section Trace Mode to Auto, skip this
step.

Step 8

Click the Disable AIS and RDI if TIM-P is detected check box if you want to suppress the alarm
indication signal (AIS) and remote defect indication (RDI) when the VC high-order path Section Trace
Identifier Mismatch Path (TIM-P) alarm appears. Refer to the Cisco ONS 15310-MA SDH
Troubleshooting Guide for descriptions of alarms and conditions.

Step 9

Click Apply.

Step 10

After you set up the section trace, the received string appears in the Received field. The following
options are available:

Caution

•

Click Hex Mode to display section trace in hexadecimal format. The button name changes to ASCII
Mode. Click it to return the section trace to ASCII format.

•

Click the Reset button to reread values from the port.

•

Click Default to return to the section trace default settings (Section Trace Mode is set to Off and the
New Transmit and New Expected Strings are null).

Clicking Default will generate alarms if the port on the other end is provisioned with a different string.
The expect and receive strings are updated every few seconds if the Section Trace Mode field is set to
Auto or Manual.
Stop. You have completed this procedure.
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NTP-H74 Create a J1 Path Trace
Purpose

This procedure creates a repeated, fixed-length string of characters used to
monitor interruptions or changes to circuit traffic.

Tools/Equipment

ONS 15310-MA SDH cards capable of transmitting and/or receiving path
trace must be installed. See Table 17-6 on page 17-27 for a list of cards.

Prerequisite Procedures Path trace can be provisioned on STM-M ( VC high/low-order path) and
Electrical circuits. See Chapter 5, “Create Circuits and VC Low-order Path
Tunnels.” for STM-M and Electrical circuit creation procedures.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43 on an ONS 15310-MA SDH node on the
network where you will create the path trace. If you are already logged in, continue with Step 2.

Step 2

As needed, complete the “DLP-H121 Provision Path Trace on Circuit Source and Destination Ports” task
on page 17-27.

Step 3

As needed, complete the “DLP-H122 Provision Path Trace on STM-M Ports” task on page 17-30.
Stop. You have completed this procedure.

NTP-H75 Create a J2 Path Trace
Purpose

This procedure creates a repeated, fixed-length string of characters used to
monitor interruptions or changes to circuit traffic.

Tools/Equipment

ONS 15310-MA SDH cards capable of transmitting and/or receiving path
trace must be installed. See Table 17-6 on page 17-27 for a list of cards.

Prerequisite Procedures See Chapter 5, “Create Circuits and VC Low-order Path Tunnels.” for
circuit creation procedures.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

You cannot create a J2 path trace on a TL1-like circuit.

Note

This procedure assumes you are setting up path trace on a bidirectional circuit and setting up transmit
strings at the circuit source and destination.

Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43 at a node on the network where you will
create the path trace. If you are already logged in, continue with Step 2.
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Step 2

From the View menu, choose Go to Network View.

Step 3

Click the Circuits tab.

Step 4

For the VC low-order path circuit you want to monitor, verify that the source and destination ports are
on a card that can transmit and receive the path trace string.

If neither port is on a transmit/receive card, you will not be able to complete this procedure. If
one port is on a transmit/receive card and the other is on a receive-only card, you can set up the
transmit string at the transmit/receive port and the receive string at the receive-only port, but you
will not be able to transmit in both directions.

Note

Step 5

Choose the VC low-order path circuit you want to trace, then click Edit.

Step 6

In the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A
detailed map of the source and destination ports appears.

Step 7

Provision the circuit source transmit string:

Step 8

Step 9

a.

On the detailed circuit map, right-click the circuit source port (the square on the left or right of the
source node icon) and choose Edit J2 Path Trace (port) from the shortcut menu.

b.

In the New Transmit String field, enter the circuit source transmit string. Enter a string that makes
the source port easy to identify, such as the node IP address, node name, circuit name, or another
string. If the New Transmit String field is left blank, the J2 transmits a string of null characters.

c.

Click Apply, then click Close.

Provision the circuit destination transmit string:
a.

On the detailed circuit map, right-click the circuit destination port and choose Edit Path Trace from
the shortcut menu.

b.

In the New Transmit String field, enter the string that you want the circuit destination to transmit.
Enter a string that makes the destination port easy to identify, such as the node IP address, node
name, circuit name, or another string. If the New Transmit String field is left blank, the J2 transmits
a string of null characters.

c.

Click Apply.

Provision the circuit destination expected string:
a.

On the Circuit Path Trace window, enable the path trace expected string by choosing Auto or
Manual from the Path Trace Mode drop-down list:
•

Auto—The first string received from the source port is automatically provisioned as the current
expected string. An alarm is raised when a string that differs from the baseline is received.

•

Manual—The string entered in the Current Expected String field is the baseline. An alarm is
raised when a string that differs from the Current Expected String is received.

b.

If you set the Path Trace Mode field to Manual, enter the string that the circuit destination should
receive from the circuit source in the New Expected String field. If you set Path Trace Mode to Auto,
skip this step.

c.

(Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match check
box if you want to suppress the Alarm Indication Signal when a C2 mismatch occurs.

d.

Click Apply, then click Close.
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Note

Step 10

Provision the circuit source expected string:
a.

In the Edit Circuit window (with Show Detailed Map chosen), right-click the circuit source port and
choose Edit Path Trace from the shortcut menu.

b.

In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual
from the Path Trace Mode drop-down list:
•

Auto—Uses the first string received from the port at the other path trace end as the baseline
string. An alarm is raised when a string that differs from the baseline is received.

•

Manual—Uses the Current Expected String field as the baseline string. An alarm is raised when
a string that differs from the Current Expected String is received.

c.

If you set the Path Trace Mode field to Manual, enter the string that the circuit source should receive
from the circuit destination in the New Expected String field. If you set Path Trace Mode to Auto,
skip this step.

d.

(Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match check
box if you want to suppress the Alarm Indication Signal when a C2 mismatch occurs.

e.

Click Apply.

Note

Step 11

Caution

It is not necessary to set the format (16 or 64 bytes) for the circuit destination expected
string; the path trace process automatically determines the format.

It is not necessary to set the format (16 or 64 bytes) for the circuit source expected string;
the path trace process automatically determines the format.

After you set up the path trace, the received string appears in the Received field on the path trace setup
window. The following options are available:
•

Click Hex Mode to display path trace in hexadecimal format. The button name changes to ASCII
Mode. Click it to return the path trace to ASCII format.

•

Click the Reset button to reread values from the port.

•

Click Default to return to the path trace default settings (Path Trace Mode is set to Off and the New
Transmit and New Expected Strings are null).

Clicking Default will generate alarms if the port on the other end is provisioned with a different string.
The expect and receive strings are updated every few seconds if the Path Trace Mode field is set to Auto
or Manual.

Step 12

Click Close.
The detailed circuit window indicates path trace with an M (manual path trace) or an A (automatic path
trace) at the circuit source and destination ports.
Stop. You have completed this procedure.
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NTP-H129 Bridge and Roll Traffic
Purpose

This procedure reroutes live traffic without interrupting service. You can
use the Bridge and Roll wizard for maintenance functions such as card
replacement or load balancing. A circuit consists of a source facility,
destination facility(s), and intermediate facilities (path).

Tools/Equipment

None

Prerequisite Procedures

•

Circuits must exist on the network. See Chapter 5, “Create Circuits
and VC Low-order Path Tunnels.” for circuit creation procedures.

•

To route circuits on protected ports, you must create a protection group
using the NTP-H142 Create Protection Groups for ONS 15310-MA
SDH, page 3-10.

•

When a roll involves two circuits, a data communications channel
(DCC) connection must exist. See the “DLP-H52 Provision Section
DCC Terminations” task on page 16-69.

•

Use the “NTP-H69 Locate and View Circuits” procedure on page 6-2
to verify that the planned Roll To paths are in service. Verify that the
planned Roll To and Roll From paths are not in the Roll Pending status,
used in test access, or used in a loopback. Refer to the
Cisco ONS 15310-MA SDH Troubleshooting Guide to clear any
alarms.

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning and higher

Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43 at the ONS 15310-MA SDH circuit source
node. If you are already logged in, continue with Step 2.

Step 2

As needed, complete the “DLP-H183 Roll the Source or Destination of One Optical Circuit” task on
page 17-72.

Step 3

As needed, complete the “DLP-H184 Roll One Cross-Connect from an Optical Circuit to a Second
Optical Circuit” task on page 17-75.

Step 4

As needed, complete the “DLP-H185 Roll Two Cross-Connects on One Optical Circuit Using Automatic
Routing” task on page 17-77 or the “DLP-H186 Roll Two Cross-Connects on One Optical Circuit Using
Manual Routing” task on page 17-80.

Step 5

As needed, complete the “DLP-H187 Roll Two Cross-Connects from One Optical Circuit to a Second
Optical Circuit” task on page 17-82.

Step 6

As needed, complete the “DLP-H189 Cancel a Roll” task on page 17-84.

Step 7

As needed, complete the “DLP-H188 Delete a Roll” task on page 17-84. Use caution when selecting this
option. Delete a roll only if it cannot be completed or cancelled. Circuits may have a PARTIAL status
when this option is selected.
Stop. You have completed this procedure.
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NTP-H76 Reconfigure Circuits
Purpose

This procedure rebuilds circuits, which may be necessary when a large
number of circuits are in the PARTIAL status.

Tools/Equipment

None

Prerequisite Procedures Circuits must exist on the network. See Chapter 5, “Create Circuits and VC
Low-order Path Tunnels.” for circuit creation procedures.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43. If you are already logged in, continue with
Step 2.

Step 2

Click the Circuits tab.

Step 3

Choose the circuits that you want to reconfigure.

Step 4

From the Tools menu, choose Circuits > Reconfigure Circuits.

Step 5

In the confirmation dialog box, click Yes to continue.

Step 6

In the notification box, view the reconfiguration result. Click Ok.
Stop. You have completed this procedure.

NTP-H77 Merge Circuits
Purpose

This procedure merges two circuits that create a single, contiguous path but
are separate circuits because of different circuit IDs or conflicting
parameters. A merge combines a single master circuit with one or more
circuits.

Tools/Equipment

Circuits must exist on the network. See Chapter 5, “Create Circuits and VC
Low-order Path Tunnels.” for circuit creation procedures.

Prerequisite Procedures None
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “DLP-H29 Log into CTC” task on page 16-43. If you are already logged in, continue with
Step 2.

Step 2

Click the Circuits tab.

Step 3

Click the circuit that you want to use as the master circuit for a merge.

Step 4

Click Edit.

Step 5

In the Edit Circuits window, click the Merge tab.
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Step 6

Choose the circuits that you want to merge with the master circuit.

Step 7

Click Merge.

Step 8

In the confirmation dialog box, click Yes to continue.

Step 9

In the notification box, view the merge result. Click Ok.
Stop. You have completed this procedure.
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